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× What is EM-Supreme? 

 EM-Supreme® is a hybrid field/device/circuit co-simulator. EM-SUPREME® is capable of 
modeling both small-ǎƛƎƴŀƭ άƛΦŜΦ {-ǇŀǊŀƳŜǘŜǊǎέ ŀǎ ǿŜƭƭ ŀǎ ƭŀǊƎŜ-signal parameters such as IP3, 
harmonics, gain, and 1dB compression point for RF & mm-Wave components like power 
ŀƳǇƭƛŦƛŜǊǎ όt!ΩǎύΣ ǎǿƛǘŎƘŜǎΣ ǇƘŀǎŜ ŀǘǘŜƴǳŀǘƻǊǎΣ ŀŎǘƛǾŜ ŀƴǘŜƴƴŀǎ ŀǎ ǿŜƭƭ ŀǎ ŎƻƳǇƭŜǘŜ ǎȅǎǘŜƳǎ ǎǳŎƘ 
as front-end modules accurately by exploiting EM, device physics, and circuit across the entire 
simulated domain. EM-Supreme®  is based on merging a 3D electromagnetic field solver with a 
device solver. The software includes EM to study and model EM-distributed effects, coupling, 
radiation, as well as parasitic effects at RF and mm-wave frequencies on active, passive, and 
ŎƻƳǇƭŜǘŜ wC ƳƻŘǳƭŜǎΦ ¢ŜŎƘƴƻƭƻƎȅ ǎǳǇǇƻǊǘŜŘ ƛƴŎƭǳŘŜǎ άōǳǘ ƴƻǘ ƭƛƳƛǘŜŘ ǘƻέΥ tI9a¢{Σ {ƛDŜΣ 
GaAs/AlGaAs/InGaP HBT, CMOS, GaAs/ AlGaAs/InGaP PIN diodes, and GaAs FETs. Users are free 
to import any other models working for them, such as TOM, Statz, Angelov , Verilog-A as well as any 

foundry-based model. Furthermore, EM-Supreme® can also be customized to fit your specific 
project needs. 
 
 

× What is EM-Core? 

EM-Core® is a fast 3D/2.5D Electromagnetic field solver software for planar-circuit and 
antenna Simulation. EM-Core® is capable of modeling both small-ǎƛƎƴŀƭ άƛΦŜΦ {-parameters and 
ƛƳǇŜŘŀƴŎŜǎέ ŀǎ ǿŜƭƭ ŀǎ ǊŀŘƛŀǘƛƻƴ ǇŀǘǘŜǊƴǎ ŀƴŘ ŦƛŜƭŘǎ ŦƻǊ ǇƭŀƴŀǊ ŎƻƳǇƻnents such as filters, 
antennas, couplers, RFIC & MMIC circuits, high density interconnects, transmission lines, 
microwave circuit discontinuities and more! EM-Core® includes EM to study and model EM-
distributed effects, coupling, radiation, as well as parasitic effects at RF and mm-Wave 
frequencies on passive structures and systems. 
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× System Requirements 
 
Windows-Based Operating System:  
Microsoft Windows XP, Windows 2000, or Windows 7.0 Windows Vista. 
AMD or Intel Pentium-based computer 
Minimum of 128MB RAM 
Minimum of 64 MB Video Card 
 

 

× Installing EM-Supreme and EM-Core 

Please refer to the installation guide provided by your PedaSoft Account Manager. If you 
would like to request one to be sent to you my email, please contact us at 
support@pedasoft.com. 
 
 
 

× For Technical Support 

Please visit our Technical Support Page, where you can access additional documentation, 
training, and the ability to submit your technical questions to our Support Team: 
http://www.pedasoft.com/support 
 
 
 

 
  

mailto:support@pedasoft.com
http://www.pedasoft.com/support
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× Useful Shortcuts 

 
3D ShortCut Keys 
 
<ALT>-A  Auto-Rotate 3D model by 360 degrees (press once) 
<ALT>-Z  Zoom-in 3D model (press and hold) 
<ALT>-Y  Zoom-out 3D model (press and hold) 
<ESC>   Finish Auto-Rotate or Finish Component Insert Mode 
<DEL>   Delete Component 
<CTRL>-Z  Undo last action  (insert or delete component) 
<CTRL>-Y  Redo last action (insert or delete component) 
<SPACE>  Rotate model by 90 degrees while adding Ports 
<LEFT-MOUSE> Drop Port or Component 
 
2D ShortCut Keys (while in Edit Mode) 
 
<DEL>   Delete currently selected metal 
<ESC>   Finish drawing Free-Draw metal shape and join last point to first 
<CTRL>-Z  Undo last move or stretch operation 
<CTRL>-Y  Redo last move or stretch operation 
<CTRL>-C  Copy metal into buffer 
<CTRL>-V  Paste metal from buffer 
<CTRL>-X  Cut metal into buffer 
<CTRL>-D  Duplicate metal (equivalent to <CTRL>-C and <CTRL>-V) 

 
2D Graph Display 
 
Use <CTRL> and Left-Mouse to select a 2nd and 3rd dataset from the pulldown listbox to display multi-
data sets in 2D graph windows. 
 
Placing Components 
 
Components are placed in 3D mode and can only be placed after at least 2 pieces of metal have been 
created.  After clicking on a component icon, by default it is positioned between the 1st and 2nd piece of 
metal.  To change its position, select a new 'From metal' and 'To metal' piece from the Component 
Properties window in the bottom right-hand corner. 
To finish placing components, press the <ESC> key. 
 
Deleting Components 
 
To delete a previously placed component, select it by using the pull-down box in the Component 
Properties window and press <DEL> to remove it. 
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× Overview 

The EM-Supreme/EM-Core interface has been designed to help simplify your project design 
experience. Here is a brief description of the components seen in the EM-Supreme window. 
 
Á Main Drop-Down Menus 

  
 
 

 
 
 

 
 
 

 
 
 
 
 

The File drop down menu will give you the ability to 
start a New Project, Open an existing Project, Close 
your current Project, or Save your Project. 
 
You will also find the option to Import and Export 
DXF. 
You can also choose to print your current 3D design. 
 
 
Your recently opened Projects will also be listed 
below. 
 
 

The Edit drop down menu enables you to Undo 
or Redo your actions.  
A selected component can also be deleted. 

The Add Item menu gives you the option to choose 
from several built in components to be added to 
your design. These components can also be 
accessed by clicking on their corresponding quick 
link symbols below. 
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The View menu lets you perform several functions to your 
о5 ŘŜǎƛƎƴΣ ǎǳŎƘ ŀǎ ½ƻƻƳƛƴƎΣ wƻǘŀǘƛƴƎΣ ŜǘŎΧ ¢ƻ Řƻ ǎƻΣ ǎƛƳǇƭȅ 
select the action that you would like to perform, then click 
on you 3D design, and move your mouse accordingly. 
These functions can also be accessed by clicking on their 
corresponding quick link symbols below. 

The Chip Designer will enable you to draw and design 
your metal in 2D view. You can also access it by clicking on 
its quick link symbol below. To learn more about this 
feature, please go to the Draw Metal section in this 
manual. 

The Options menu gives you access to change the Settings 
and the Units, as discussed below.  

/ƘŀƴƎŜ ȅƻǳǊ ƳŜǘŀƭΩǎ ŎƻƭƻǊ 

Specify the thickness and the conductivity of your 
metal. 

The Bridge Depth and Line Width are set by 
default, but can be changed according to 
your specifications. 

The Frequency Range is set from 1 to 20 GHz by default, but 
can be set according to your project requirements. 

You can choose whether 
or not you want radiation. 

You can choose to have Single, 
Differential, or Common Ports. 

Control simulation for Large-Signal or 
Small Signal Parameters.  

Set you Frequency Sweep 

Set your Mesh Density Select to show a 2D Grid 

Set the Substrate Loss 
Tangent (0 by default). 

Set the Port Reference for de-
embedding S-parameters. It is set 
to 10 by default. The value chosen 
must be greater than 10.  You can choose to have a Metal at the bottom 

of the substrate. 
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You can set the unit for length 
to mm, cm, Microns, or mil. 

The units for Frequency, 
Capacitance, Inductance, and 
Resistance are set by default 
and cannot be changed. 

The Windows drop down menu lets you 
enable or disable specific windows in your 
work area. You can also restore to the 
default positions after making unwanted 
changes. These windows are explained in 
greater detail later in this manual.  
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Á Quick Links Toolbar 

 

 

 

 

 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The Help menu gives you access to our Quick Help 
section, where you will find information about the 
most common issues.  

Start a 
New 

Project 

Open a 
previously 

saved 
Project 

Save your 
Project 

Save 
your 

Project 
with a 
new 

name 

Print 

Undo 
and 
Redo Import/

Export 
DXF 

Zoom, Rotate, Pan, 
and Expand your 

3D Design 

Reset 
your 

changes 
to the 
View 

Reset 
Component 

Mode 

Add a 
Resistor 

Add a 
Capacitor 

Inductor 

Pin Diode 

Bond 
Wire 

Port 

Chip 
Designer 

Mode 

Help 

Stop 
Current 

Simulation 

Delete 
Selected 

Component 
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Á Control Panel 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Click here to start designing your Model. 

After finishing your design, and adding all the 
necessary ports, you can then click here to run 
the Simulation. 

When the Simulation has ended, you can then 
click here to view the Results. 

You can then also click here to view the 
Radiation Pattern. 

Max value of Dx, Dy, and Dz.  
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Á Properties Panel 

 
 
  
Á Chip Designer (Draw Metal) 

       In Chip Designer mode, you can easily draw and design your metal in 2D, using basic 
geometric shapes, freehand, or built in shapes such as spirals and bridges. 

 

 
 
 

 
 
 
 
 
 

You can change the properties of your domain 
by clicking on each corresponding cell, and 
inputting the desired value. 

You can edit the properties of all of the 
components that you are currently using. 
 
First click on the drop down menu, then select 
the desired component from the list. 
 
You can then start editing/changing all of the 
desired values for that particular component. 

The File drop down menu gives you the ability 
to save the changes to your metal design, and to 
display the Geometry File.  
By Closing the Window, you can get out of Chip 
Designer Mode. 
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The Edit menu gives you access to entering Edit 
Mode, where you can edit your metal designs in 
greater precision, by setting their exact location, and 
changing their geometric properties. 
You can also Cut/Copy, Paste, Delete and Duplicate a 
ǎŜƭŜŎǘŜŘ ǎƘŀǇŜΦ ¢ƘŜ DǊƛŘΩǎ 5ƛƳŜƴǎƛƻƴǎ Ŏŀƴ ŀƭǎƻ ōŜ ǎŜǘ 
here. 

The View menu lets you Zoom in or out, by first clicking 
on Zoom in, then selecting the exact area that you 
would like to zoom in to, and Zoom out to go back.  

The Add Item drop down menu has a list of 
geometric shapes and predesigned built in shapes 
for your metal design needs. Just click on the desired 
shape, and set its location and size on the grid by 
clicking and dragging. 
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Á Chip Designer QuickLinks 

 
 
 
 
 
 
 

 
  
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Open 
Geometry 

File 

Save 
Geometry 

File 

Cut, Copy, Paste 
a selected object 

Zoom in/out 

Enter Edit 
Mode 

Change 
Grid 

Dimensions 

Switch 
between 

real or grid 
coordinates 

Deleted 
Metal 

Object (in 
Edit Mode) 

Duplicate a 
selected 
shape (in 

Edit Mode) 

Draw 
Square/ 
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Draw 
Triangle 

Draw 
Circle 

Draw 
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Draw 
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Draw 
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Draw 
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Draw 
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Draw n-
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Draw 
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× Example #1: 4-Port Coupler Simulation  

 
 

Á To start designing this device, first click on Model   located in your Control 

Panel. 

Á Then, go to the Options drop down menu and select Settings. 

Á Make sure you have a metal at the bottom of your substrate by selecting Yes for Metal 

at Bottom, and set your Frequency Range from 1 to 20GHz, then press OK.  

Á You can make all your necessary changes to Dx, Dy, and Dz in the Control Panel. Keep in 

mind, however, that these values need to be lower than the Max value posted above 

(with Max being a function of the dielectric constant, the frequency range, and the 

mesh density). Choose Dx=0.4064, Dy = 0.265, and Dz = 0.4233. (Tip: for faster 

simulations Dx, Dy, and Dz may be set as close as possible to MAX, which can be 

achieved by increasing/decreasing the maximum frequency range in the Options-

Settings). 

Á You can also set proper bridge depth (if applicable), line width  and mesh density  in 

Settings window, which will help the software generating a proper initial mesh. 

o mesh density is in cells/wavelength, the wavelength here is the minimum one 

associated with the upper limit of the simulation frequency range.  

Á Go to Chip Designer by clicking on the icon . You can now start editing your metal in 

2D. 

Á Click on the Edit drop down menu and select Change Grid Dimensions. Set the 

dimensions to 80x100. 
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Á To start editing your metal design shape, first click on the Draw Rectangle icon , 

ǘƘŜƴ ŎƭƛŎƪ ŀƴŘ ŘǊŀƎ ǘƻ ŦƻǊƳ ȅƻǳǊ ŦƛǊǎǘ ǊŜŎǘŀƴƎǳƭŀǊ ǎƘŀǇŜΦ ¸ƻǳ Ŏŀƴ ŜŘƛǘ ȅƻǳǊ ƳŜǘŀƭ ǎƘŀǇŜǎΩ 

dimensions and location by Going to Edit Mode  and:  

o Using your mouse to click, drag and resize your shapes, or just clicking on the 

metal shape and using your arrow keys to position it. 

o Or you can just click on the desired shape, and manually enter its exact 

dimensions and location in the Properties panel located on the right. 

To get out of Edit Mode, simply click on the  icon again. 

Á Set the properties of your first rectangle to: 

 

 

 
Your Metal Design so far should look like this: 

 
Á You can now add the 3 other identical rectangles, by simply duplicating this shape. To 

do so, go to Edit Mode, click on the shape you wish to duplicate, and either click on the 

duplicate icon , or press ctrl+d on your keyboard. 

 

Á Once your 4 rectangles are in place, with the top and bottom right triangles set at a 

Centre x=44, your Metal design should look like this: 

 
 

You can also click on the  
icon to change the values from 

Grid Units to actual 
Coordinates. 
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Á You will now need to add the 2 horizontal bars with the following dimensions: 

  
 

Make sure to line them up so your overall design looks like this: 

 
 

Á You now need to add the last 2 vertical bars with the following dimensions: 

 
 

When these 2 metal rectangles are in place, the overall design should look like this: 
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Á Now that you have your metal designed, click on  to get out of the 

Chip Designer mode. 

Á To finalize your design, you will now need to add the 4 ports. To do so, simply click on 

the port symbol , and then add all the 4 ports at the proper positions between the 

metals and the ground.  When you are done adding your ports, press Esc on your 

keyboard.   

(Tip: Remember to use the View functions such as Pan and Rotate to have a better visual 

of the port area.  <SPACE> is extremely useful for adding ports by axially rotate the 

model 90 degree each time) 

o To delete the port you don't want, just select the specific port from the first row 

of Component Properties, then press on your keyboard.  

Your overall final design should look like this: 

 
 

Á Now that you are done with your design, you can start running the simulation by clicking 

on the Simulation button . 
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Á The Simulation should take about 10 minutes. When it is complete, you can view the 

Results by clicking on . 

Á When you first open up your Results window, the two graphs should look blank: 

 

 
 

Á To start viewing the graph results, click on the desired Port File located in the S-

Parameter and Smith Chart Control Panels. If you would like to view multiple port 

files in one graph, simply click on all the desired port files while holding the Ctrl 

key on your keyboard. 

 

IŜǊŜΩǎ ŀƴ ŜȄŀƳǇƭŜ ƻŦ ǘƘŜ {-Parameter graph: 
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Á You can set the exact specifications of your graph by changing the Range in your 

S-Parameter and Smith Chart Control Panels. 

 

 
Á  

 
 

 
 

 

 

 

In the Smith Chart Control 
Panel, you can click and drag 
the cursor or use the arrow 
keys to display frequency 
values at certain positions on 
your graph. 

  

 



 

20 

 

× Example #2: Low Pass Filter Simulation  

 
 

Á To start designing this device, first click on Model   located in your Control 

Panel. 

Á Then, go to the Options drop down menu and select Settings. 

Á Make sure you have a metal at the bottom of your substrate by selecting Yes for Metal 

at Bottom, and set your Frequency Range from 1 to 20GHz, then press OK.  

Á You can make all your necessary changes to Dx, Dy, and Dz in the Control Panel. Keep in 

mind, however, that these values need to be lower than the Max value posted above 

(with Max being a function of the dielectric constant, the frequency range, and the 

mesh density). Choose Dx=0.4064, Dy = 0.265, and Dz = 0.4233. (Tip: for faster 

simulations Dx, Dy, and Dz may be set as close as possible to MAX, which can be 

achieved by increasing/decreasing the maximum frequency range in the Options-

Settings). 

Á You can also set proper bridge depth (if applicable), line width  and mesh density  in 

Settings window, which will help the software generating a proper initial mesh. 

o mesh density is in cells/wavelength, the wavelength here is the minimum one 

associated with the upper limit of the simulation frequency range.  

Á Go to Chip Designer by clicking on the icon . You can now start editing your metal in 

2D. 

Á Click on the Edit drop down menu and select Change Grid Dimensions. Set the 

dimensions to 80x100. 

Á To start editing your metal design shape, first click on the Draw Rectangle icon , 

ǘƘŜƴ ŎƭƛŎƪ ŀƴŘ ŘǊŀƎ ǘƻ ŦƻǊƳ ȅƻǳǊ ŦƛǊǎǘ ǊŜŎǘŀƴƎǳƭŀǊ ǎƘŀǇŜΦ ¸ƻǳ Ŏŀƴ ŜŘƛǘ ȅƻǳǊ ƳŜǘŀƭ ǎƘŀǇŜǎΩ 

dimensions and location by Going to Edit Mode  and:  


